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Predgovor 

Današnje društvo obilježeno je naglim rastom i razvojem informacijske tehnologije 

(IT), što je rezultiralo velikom ovisnošdu društva, u širem smislu, o znanju i 

kompetencijama osobe u IT području. I premda ta ovisnost raste iz dana u dan, 

ljudsko pravo na obrazovanje i informacije nije prošireno i na IT područje. Pojavili 

su se problemi koji utječu na društvo u cjelini, koji stvaraju prepreke i udaljavaju 

ljude od glavnog razloga i motivacije za napredak, od prilike. Danas, biti računalno 

nepismena osoba, znači biti osoba koja nije u mogudnosti sudjelovati u modernom 

društvu, osoba bez prilike, i unatoč priznatoj neophodnosti i korisnosti inkluzivne 

informatičke pismenosti, od strane Europske komisije, UNESCO-a, OECD-a i ostalih 

relevantnih institucija, još uvijek postoje grupe ljudi sa otežanim pristupom 

osnovnoj računalnoj naobrazbi (npr. osobe s invaliditetom, osobe s poteškodama 

u učenju, radnice/i migranti, nezaposlene osobe, osobe koje žive na udaljenim 

mjestima gdje nemaju pristup računalnoj edukaciji). 

 

Ovaj priručnik, zajedno sa ostalim materijalom objavljenim na stranici ITdesk.info, 

predstavljaju naš doprinos realizaciji I promociji ljudskog prava na edukaciju i 

informacije u IT području. Nadamo se da de Vam ova edukacija pomodi u 

savladavanju osnovnih računalnih vještina i sa tom nadom želimo Vam da naučite 

što više i tako postanete aktivni/a član/ica modernog IT društva. 

 

Iskreno Vaši, 

ITdesk.info team Lektor: 
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Dio 1 Pregledavanje Web-a 

TERMINI VEZANI UZ INTERNET 

Internet („mreža nad mrežama“) je skup milijuna međusobno povezanih računala i 
računalnih mreža koji komuniciraju putem IP grupe protokola (TCP/IP).  

WWW (World Wide Web, W3, Web) je mrežna usluga koja omoguduje pretraživanje resursa 
na Internetu. Sastoji se od mnoštva dokumenata međusobno povezanim hipervezama. 
WWW je jedan od najkorištenijih servisa Interneta, a pristupamo mu putem web 
preglednika. 

ISP (Internet Service Provider) ili Pružatelj internetskih usluga je tvrtka ili organizacija koja 
omogudava pristup Internetu za svoje korisnike.  

Hiperveze (Hyperlink) služe za povezivanje sadržaja na web stranicama. Pomodu hiperveze 
možemo:  

 dodi na drugi dio stranice na kojoj se nalazimo  

 dodi na drugu stranicu unutar iste web lokacije 

 dodi na stranicu na nekoj drugoj web lokaciji 

 preuzimati datoteke (download) 

 pokretati aplikacije, zvučne ili video zapise, ostvariti vezu na e-mail adresu (mailto) 

URL (Uniform Resource Locator) je web adresa resursa (dokumenata) koji se nalaze na 
internetu. Sastavni dijelovi URL-a su: protokol, ime poslužitelja, broj porta i lokacija 
dokumenta na poslužitelju. 

Web adresa se sastoji od: protokola http, znaka dvotočke i dvije kose crte (://) koji separiraju 
protokol od ostalih elemenata adrese, naziva računala, naziva mapa u kojima je smješten 
dokument i naziva tog dokumenta.  

Pr.  http://www.itdesk.info/hr/  

Web preglednik (Web Browser) je program koji koristimo za pregled web stranica. 
Najpopularniji preglednici su Internet Explorer, FireFox, Chrome, Safari, Opera. 

Tražilice (Search Engine) koristimo za pretraživanje informacija na WWW-u. Tražilice čuvaju 
podatke o web stranicama (ključne riječi, posjedenost stranice...). Rezultati pretraživanja se 
prikazuju u obliku liste predloženih adresa kojima možemo pristupiti u potrazi za željenim 
informacijama.  

 RSS (Really Simple Syndication) je skup web formata koji se koriste za stranice koje se 
stalno osvježavaju. Olakšana mogudnost prijenosa neke informacije (vijesti, unosa u blog i sl.) 
objavljene na web stranici na standardiziran način (obično: naslov, rečenica ili dvije članka te 
link na stranicu na kojoj se nalazi cijeli članak). Preplatom na RSS sa različitih web stranica, 

http://www.itdesk.info/hr/
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korisnici su obaviješteni o novostima bez odlaska na dotične stranice. 

Podcast (POD-Personal On Demand + Broadcast) je datoteka s audio ili video sadržajem koja 
se distribuira upotrebom RSS tehnologije.  

 

SIGURNOSNE TEME VEZANE UZ INTERNET 

Web adresa sigurnog mjesta počinje s protokolom https, a u adresnoj (ili statusnoj ovisno o 
pregledniku) traci se pojavljuje znak lokota    . Sigurne veze koriste certifikate da bi 
identificirale web mjesto. Kada kliknemo na znak lokota, prikazuju nam se dodatne 
informacije o web mjestu (izvješde o sigurnosti). Certifikati s detaljnijom provjerom 
(Extended Validation), označavaju adresu zelenom bojom. (odnosi se na Internet Explorer 8 i 
9) 

Digitalni certifikati su elektroničke isprave koje potvrđuju identitet neke osobe na Internetu. 
Omoguduje sigurnu komunikaciju – npr. pristup bankovnim računima. 

Enkripcija ili šifriranje je proces u kriptografiji kojim se neki podatak čini nečitljivim za osobe 
koje ne posjeduju potrebno znanje (ključ). Šifriranjem podatke štitimo od neovlaštenog 
pristupa (e banking, zaštita bežičnih mreža...). 

Zlodudni softver (Malware) je softver koji se na neprimjetan način infiltrira u operativni 
sustav gdje radi neku vrstu štete. Pod zlodudni softver spadaju:  

 Virus je zlonamjeran program s mogudnošdu autoreplikacije. U računalu traži druge 
datoteke nastojedi ih inficirati, a krajnji cilj mu je širenje na druga računala. Ovisno o 
zlonamjernom kodu koji sadrži, uzrokuje vede ili manje štete na računalu. Virus se širi 
prenošenjem i otvaranjem zaraženih datoteka (e-mail privici, zaražene datoteke na 
prijenosnim medijima...) 

 Crvi kao i virusi posjeduju mogudnost autoreplikacije, ali ne mogu inficirati druge 
programe. Obično im je namjena preuzeti kontrolu nad računalom i omoguditi 
udaljen pristup otvaranjem tzv. stražnjih vrata (engl. backdoor) programeru crva 

 Trojanski konji mogu biti predstavljeni u obliku igre ili datoteke u e-mail privitku koje 
nakon pokretanja na računalo obično instaliraju aplikaciju za udaljenu kontrolu 

 Spyware je program koji neovlašteno prikuplja podatke o korisniku računala 

 Adware je program koji se koristi skupljenim podacima o korisniku da bi na osnovu 
njih na nametljiv način prikazivao reklame. Obično se manifestira iskakanjem 
mnoštva skočnih prozora (pop-up windows) 

 Hoax su lažne poruke koje se šire e-mailom s ciljem zagušenja prometa na internetu 
ili s ciljem prevare primaoca poruke 

Antivirusne programe koristimo da bi pronašli i uklonili maliciozni softver. Potrebno ga je 
redovito ažurirati, odnosno preuzimati nove definicije virusa (najbolje mu je zadati da to sam 
radi automatski prilikom spajanja). Inače, ukoliko ne ažuriramo antivirusni program redovito, 
on postaje beskoristan jer ne može detektirati nove vrste zlodudnog softvera. 
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Više o zaštiti od virusa i drugih malicioznih programa možete saznati u priručniku Osnovni 

pojmovi informacijske tehnologije, u poglavlju Zaštita prilikom korištenja ICT tehnologije, 

objavljenom na slijededem linku: 

http://www.itdesk.info/prirucnik_osnovni_pojmovi_infomacijske_tehnologije.pdf . 

Vatrozid (Firewall) je program (ili mrežni uređaj) koji koristimo za kontrolu ovlaštenog i 
zaštitu od neovlaštenog pristupa računalu.  

Autentifikacija korisnika podrazumijeva postupak identifikacije korisnika da bi mu se 
omogudio pristup nekom sadržaju (podacima). Npr. ako putem preglednika želimo provjeriti 
elektroničku poštu, za pristup računu, moramo unijeti korisničko ime i lozinku. Ukoliko su 
podaci točno uneseni, pristup nam se odobrava.  

Osim opasnosti od zaraze računala virusom (osobito što se tiče pohrane podataka sa 
Interneta na računalo, eng. download), trebamo paziti da nenamjerno odamo osobne 
podatke što može imati niz neželjenih posljedica: 

 ostavljanje svoje e-mail adrese na sumnjivim web stranicama može rezultirati 
velikim brojem neželjenih poruka (eng. spam, junk mail) 

 davanje podataka svoje kreditne kartice za kupovinu putem Interneta web 
stranicama koje nisu pouzdane, čime se stvara opasnost zlouporabe tog bankovnog 
računa 

Putem značajke roditeljskog nadzora možete upravljati načinom na koji vaše dijete koristi 
računalo. Možete podesiti pojedinačne postavke nadzora, poput:  

 Ograničenja internetskog sadržaja - možete postaviti ograničenja u pogledu web-
mjesta koje vaša djeca mogu posjetiti. 

 Vremenska ograničenja - možete postaviti vremenska ograničenja da biste 
kontrolirali koliko vremena djeca provode za računalom. 

 Igre - možete nadzirati pristup igri, odabrati razinu pogodnu za određenu dob, 
odabrati vrste sadržaja koje želite blokirati te odabrati želite li dopustiti pristup ili 
blokirati neocijenjenu ili određenu igru. 

 Dopuštanje ili blokiranje određenih programa - djeci možete omoguditi ili 
onemoguditi pokretanje određenih programa. 

  

http://www.itdesk.info/prirucnik_osnovni_pojmovi_infomacijske_tehnologije.pdf
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WEB PREGLEDNICI 

Otvaranje web preglednika: 

 dva puta brzo kliknemo na prečicu (shortcut) web preglednika, koji se obično nalazi 
na radnoj površini (dekstop) računala 

 putem izbornika Start  Svi programi (All Programs)  Internet Explorer (ili Mozilla 
Firefox) 

 putem ikone preglednika prikvačenog na programsku traku  

 u izborniku Start pod okvirom za pretragu upišemo naziv preglednika i u ponuđenim 
rezultatima kliknemo na njega 

       

Sl.1. Prečac (shortcut) preglednika Mozilla Firefox Sl.2. Prečac (shortcut) preglednika IE9 

 

Sl.3. Programska traka (taskbar) 

Zatvaranje preglednika: 

 pritiskom na manipulacijski gumb   

 pritisnemo desnu tipku miša na naslovnu traku programa i iz brzog izbornika 
odaberemo naredbu Zatvori (Close) 

 kombinacijom tipki Alt + F4 

 * u izborniku Datoteka (File) odaberemo naredbu Izađi (Exit)  

* (IE9) Da bi nam ova opcija bila dostupna, potrebno je uključiti Traku izbornika (Menu bar) 
– desni klik na naslovnu traku i u izborniku odabrati Traka izbornika (Menu bar) 

Adresu web stranice upišemo u Adresnu traku (Address Bar) i kliknemo na  (Go to) ili 
pritisnemo tipku Enter.  

   

Sl.4. Adresna traka (Adress bar) 
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Prikazivanje Web stranice u novom prozoru ili tab-u 

Pritiskom desne tipke miša na hipervezu (link) pozivamo brzi 
izbornik. Naredbom Otvori novu karticu (Open in New Tab) – 
hipervezu otvaramo u novoj kartici (tab) koja se nalazi desno od 
kartice putem koje smo je otvorili. Naredbom Otvori novi prozor 
(Open in New Window) – hipervezu otvaramo u novom prozoru 
preglednika.  

 

 

 

Sl. 5. Brzi izbornik 

Ukoliko imamo otvoreno više kartica (tab), prilikom zatvaranja aplikacije Internet Explorer 9 
pojavit de se dijaloški okvir sa slijededim opcijama: 

 Zatvori sve kartice (Close all tabs) – 
zatvara sve kartice (tab) u pregledniku 

 Zatvori trenutnu karticu (Close current 
tab) - zatvara samo karticu na kojoj se 
trenutno nalazimo  

 Sl. 6. Zatvaranje preglednika IE9 

Otvaranje nove kartice (tab): 

 pritiskom na ikonu Nova kartica (New Tab) s desne strane otvorene kartice   

 kombinacijom tipki Ctrl + T 

 * preko izbornika Datoteka (File), odabirom naredbe Nova kartica (New Tab) 

* (IE9) Da bi nam ova opcija bila dostupna, potrebno je uključiti Traku izbornika (Menu bar) 
– desni klik na naslovnu traku i u izborniku odabrati Traka izbornika (Menu bar) 

 

Zaustavljanje daljnjeg učitavanja Web stranice: 

 pritiskom na gumb Zaustavi (Stop) koji se nalazi s desne strane adresne trake 

 tipkom Esc 

 * preko izbornika Prikaz (View) odabirom naredbe Zaustavi (Stop) 

* Potrebno je uključiti Traku izbornika (Menu bar) 
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Osvježavanje Web stranice 

 pritiskom na gumb Osvježi (Refresh)  

 desnim klikom unutar prozora aplikacije otvaramo brzi izbornik u kojem odabiremo 
naredbu Osvježi (Refresh) 

 tipkom F5 

 preko izbornika Prikaz (View) odabirom naredbe Osvježi (Refresh) 

* Potrebno je uključiti Traku izbornika (Menu bar) 

 

Korištenje funkcije pomodi 

Funkciji pomod pristupamo putem: 

 *Trake izbornika (Menu bar), korištenjem izbornika Pomod (Help) 

 *Naredbene trake (Command bar), pritiskom na gumb Pomod (Help) 

 Pritiskom na funkcijsku tipku F1 na tipkovnici 

* Traku izbornika (Menu bar) i Naredbenu traku (Command bar) je prvo potrebno uključiti 

 

Postavljanje polazne/početne stranice u pregledniku 

Možemo podesiti da prilikom pokretanja web preglednika se učita stranica (ili više stranica) 
po našem izboru. Web stranica koja se automatski učitava prilikom pokretanja web 
preglednika se naziva polazna ili početna (Home Page), a podešavamo ju na slijedede načine: 

 Pritiskom na gumb Tools (Alati)  otvaramo 
padajudi izbornik u kojem biramo Internetske 
mogudnosti (Internet Options) ili  

 Naredbi Internetske mogudnosti (Internet 
Options), možemo pristupiti i preko izbornika Alati 
(Tools) u *Naredbenoj traci (Command bar) ili 
*Traci izbornika (Menu bar) 

 

 Sl.7. Izbornik Alati (Tools) 

* Naredbenu traku (Command bar) ili *Traku izbornika (Menu bar) uključujemo tako da na 
naslovnoj traci programa, pritisnemo desnu tipku miša i u izborniku odaberemo alatnu traku 
koju želimo prikazati.  
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U otvorenom dijaloškom okviru Internetske 
mogudnosti (Internet Options) na kartici 
Opdenito (General), u grupi Početna 
stranica (Home Page) upisujemo web 
stranicu koju želimo prikazivati kao početnu 
(npr. http://www.google.com). Ukoliko 
želimo više početnih stranica (prilikom 
otvaranja preglednika svaka se otvara u 
svojoj kartici, eng. tab), stranice u okvir 
upisujemo jednu ispod druge i potvrđujemo 
odabir.  

 

 

Sl.8. Dijaloški okvir Internetske mogudnosti 
(Internet Options) 

 

Vradanje na početnu stranicu 

Pritisak na gumb Polazno (Home) , kao i kombinacija tipki Alt + Home, vradaju nas na 
početnu stranicu (Home Page).  

 

Brisanje povijest pregledavanja  

U dijaloškom izborniku Internetske mogudnosti (Internet Options) na kartici Opdenito 

(General), u grupi Povijest Pregledavanja (Browsing History) kvačicom označavamo opciju 

Izbriši povijest pregledavanja pri izlasku (Delete Browsing History on Exit). Pritiskom na 

gumb Izbriši (Delete) otvaramo novi dijaloški okvir Izbriši povijest pregledavanja (Delete 

Browsing History) u kojem označavamo pojedine stavke koje želimo izbrisati.  

Ostali načini: 

 gumb  Alati (Tools) → Sigurnost (Safety) → Izbriši povijest pregledavanja (Delete 
Browsing History) 

 *Naredbena traka (Command bar) → Sigurnost (Safety) → Izbriši povijest 
pregledavanja (Delete Browsing History) 

 *Traka izbornika (Menu bar) → Alati (Tools) → Izbriši povijest pregledavanja 
(Delete Browsing History) 

 kombinacija tipki Ctrl + Shift + Del 
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Sl.9. Brisanje 
povijesti 
pregledavanja 

 

 

Uključivanje / isključivanje blokade skočnih prozora  

Skočne prozore (Pop-up) onemogudujemo na kartici Privatnost (Privacy) dijaloškog okvira 
Internetske opcije (Internet Options), tako da stavimo kvačicu pokraj opcije Uključi blokadu 
skočnih prozora (Turn on Pop-up blocker). 
Za isključivanje blokade skočnih prozora, 
dovoljno je ukloniti kvačicu pokraj te 
opcije. 

Drugi način: 

Preko *Naredbene trake (Command bar) 
ili *Trake izbornika (Menu bar) → Alati 
(Tools) → Blokator skočnih prozora (Pop-
up Blocker) → Uključi/Isključi blokadu 
kočnih prozora (Turn on/off Pop-up 
Blocker) 

*Potrebno ih je uključiti  

 

Sl.10. Dijaloški okvir Internet opcije  
– kartica Privatnost 
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Dozvoljavanje, blokiranje kolačida (cookies) 

Kolačid (cookie) tekstualna datoteka koju Web stranica sprema na naše računalo radi lakše 
komunikacije između korisnika i stranica.  

Za blokiranje kolačida (cookies), potrebno je odabrati karticu Privatnost (Privacy), dijaloškog 
okvira Internetske opcije (Internet Options) i u opciji Postavke (Settings) pomaknuti klizač 
na vrh. Ukoliko želimo dopustiti sve kolačide, klizač demo odvudi do dna. 

Brisanje privremenih Internet datoteka 

Privremene Internet datoteka brišemo putem dijaloškog okvira Internetske mogudnosti 
(Internet Options), u kartici Opdenito (General), pod opcijom Povijest pretraživanja 
(Browsing History). Potrebno je odabrati Postavke (Settings), označiti opciju Privremene 
Internet datoteke (Temporary Internet Files) i pritisnuti gumb Obriši (Delete). 

Prikazivanje i skrivanje ugrađenih alatnih traka 

Desni klik na naslovnu traku otvara izbornik s alatnim 
trakama (Menu bar, Favorites bar, Command bar, Status 
bar) koje prema potrebi uključujemo ili isključujemo.  

Kada je uključena Traka izbornika (Menu bar), prikaz 
alatnih traka možemo podesiti u izborniku Prikaz (View), 
odabirom naredbe Alatne trake (Toolbars). 

Sl.11. Izbornik – uključivanje alatnih traka 

 

Aktiviranje hiperveze (hyperlink) 

Pozicioniramo se pokazivačem miša na hipervezu (eng. hyperlink; skradeno: link). Kada je 

pokazivač iznad hiperveze, on mijenja oblik u . Ako tada pritisnemo lijevu tipku miša, 
aktivirat demo hipervezu. 

 

Kretanje naprijed i natrag među ved posjedenim stranicama: 

 navigacijskim strelicama Natrag (Back) i Naprijed (Forward)  u gornjem 
lijevom kutu stranice 

 kombinacijama tipki: Alt + tipka sa strelicom ulijevo te Alt + tipka sa strelicom 
udesno 

 desnim klikom na radnu površinu preglednika i odabirom naredbi Natrag (Back) i 
Naprijed (Forward) 
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Prikazivanje posjedenih adresa  

Klikom na strelicu  u adresnoj traci, 
otvaramo popis posjedenih adresa. 

 
 Sl. 12. Prikaz posjedenih adresa preko  

Adresne trake (Address bar) 

 
Ili  

Pritisnite gumb Favorit (Favorite)  i odaberite karticu 
Povijest (History). 

 

 

 

Sl.13. Kartica Povijest (History)      

Označavanje stranica (Favorite, Bookmark) 

Ukoliko neku stranicu želimo „zapamtiti“, tako da je ne moramo kasnije ponovo tražiti, 
dodajemo je u favorite: 

 učitamo stranicu koju želimo označiti  

 pritisnemo gumb Favorit (Favorite)  i odaberemo 
naredbu Dodaj u favorite (Add to Favorites) 

 potvrđujemo predloženo ime ili unesemo novo ime 
favorita 

 opcijom Stvori u (Create in) određujemo mapu u 
koju demo dodati adresu stranice 

 gumbom Nova mapa (New Folder) kreiramo novu 
mapu za pohranjivanje favorita 

 gumbom Dodaj (Add) potvrđujemo odabir  

Sl.14. Kartica Favoriti (Favorites) 

Drugi način: *Traka izbornika (Menu bar) → naredba Dodaj u favorite (Add to Favorites)  

 *Po zadanom, Traka izbornika (Menu bar) se ne 
prikazuje, potrebno ju je uključiti 

 
Sl.15. Dijaloški okvir Dodaj favorit  
(Add a Favorite) 
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Označene stranice pregledavamo: 

 pritiskom na gumb  → kartica Favoriti (Favorites) 

 putem izbornika Favoriti (Favorites), na *Traci izbornika (Menu bar) 

Organiziranje označenih stranica u mape 

U izborniku Favoriti (Favorites) odabiremo naredbu Organiziraj favorite (Organize 
Favorites). Otvara nam se istoimeni dijaloški okvir u kojem možemo reorganizirati označene 
stranice - preimenovati ili izbrisati označene 
stranice, premjestiti ih u postojede ili 
novokreirane mape. Opcije dijaloškog okvira: 

 Nova mapa (New folder) – kreira novu 
mapu 

 Premjesti (Move) – premješta stranicu u 
odabranu mapu 

 Preimenuj (Rename) – promjena imena 
mape ili stranice 

 Izbriši (Delete) – briše mapu ili stranicu 
 
 

Sl.16. Dijaloški okvir Organiziraj favorite  
(Organize Favorites) 

Brisanje označenih stranica: 

 Naredbom Izbriši (Delete) u dijaloškom okviru Organiziraj favorite (Organize 
Favorites) 

 U izborniku Favoriti (Favorites) pritisnemo desnu tipku miša na stranicu koju želimo 
izbrisati i u brzom izborniku odaberemo naredbu Izbriši (Delete) 

U dijaloškom okviru Organiziraj favorite (Organize Favorites): 

 stranicu povučemo u mapu (drag and drop) 

 nakon što smo stranicu označili, pritisnemo gumb Premjesti (Move), a zatim 
odaberemo odredišnu mapu  
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WEB OBRASCI 

Mnogi web servisi traže da se ispuni nekakav obrazac prije nego što ih se koristi. Svrha web 
obrazaca je skupljanje podataka o korisnicima/cama, kako bi usluga koju pružaju bila 
personalizirana. Imajte na umu da ostavljanje osobnih podataka na sumnjivim stranicama 
može imate neželjene posljedice, stoga budite oprezni gdje ostavljate osobne podatke.   

Ispod se nalazi primjer web obrasca za otvaranje G-mail računa. 

Otvaranje Gmail računa – popunjavanje web obrasca 

Gmail račun otvaramo tako da otvorimo popularnu tražilicu Google, koja se nalazi na adresi 
http://www.google.hr/ Na stranici odabiremo hipervezu Gmail, nakon čega se otvara 
stranica za prijavu i registraciju korisnika. Za kreiranje novog računa (registraciju korisnika), 
potrebno je pritisnuti gumb „Otvorite račun“. 

  Sl.17. Kreiranje novog računa 

Otvara nam se obrazac čija polja popunjavamo podacima. Za početak u tekstualne okvire 
unosimo svoje ime i prezime te ime za prijavu (alias) koje de biti dio naše e–mail adrese. 
Nakon toga, upotrebom gumba provjeri dostupnost!, provjeravamo dostupnost imena za 
prijavu. Ukoliko je ime zauzeto, upisujemo novo ime za prijavu ili prihvadamo neko od 
generiranih imena za prijavu. 

 Sl.18. Unos osobnih podataka 

Zatim je potrebno unijeti zaporku minimalne duljine osam znakova. Pri odabiru zaporke 
savjetuje se korištenje interpunkcijskih znakova i brojeva kao i kombiniranje velikih i malih 
slova (Više o izboru sigurne zaporke možete saznati u priručniku 
Osnovni_pojmovi_infomacijske_tehnologije, poglavlje: Zaštita prilikom korištenja ICT 
tehnologije). Sustav zatim procjenjuje njenu jakost – ukoliko je zaporka procijenjena kao 
slaba, vrlo je poželjno kreirati novu. Zaporku je potrebno potvrditi ponovnim upisom.  

Kvačicom demo označiti dva potvrdna okvira ukoliko želimo ostati prijavljeni i prihvadamo 
uslugu Web povijesti.  

http://www.google.hr/
http://www.itdesk.info/prirucnik_osnovni_pojmovi_infomacijske_tehnologije.pdf
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Sl.19. Kreiranje zaporke 

Ukoliko smo zaboravili zaporku, sustav de nas tražiti da odgovorimo na sigurnosno pitanje. 
Sigurnosno pitanje možemo odabrati iz liste ponuđenih pitanja u padajudem izborniku 
(potrebno je kliknuti na strelicu) ili ga sami kreirati (odabirom opcije „napišite vlastito 
pitanje“). Odgovor na sigurnosno pitanje upisujemo u tekstualni okvir ispod okvira 
sigurnosnog pitanja.  

 Sl.20. Sigurnosno pitanje 

U slijededi tekstualni okvir upisujemo alternativnu adresu e-pošte (ako je imamo). Ova opcija 
se koristi za provjeru autentičnosti računa i oporavak zaporke (u slučaju da smo je 
zaboravili).  

 

Sl.21. Povratna 
adresa e – pošte 

U padajudem izborniku odabiremo lokaciju.  

 Sl.22. Odabir lokacije 

U tekstualni okvir Provjera riječi upisujemo slova sa iskrivljene slike. Ovaj podatak služi za 
potvrdu da osoba pokušava otvoriti korisnički račun, a ne o bot). 

 Sl.23. Sigurnosna provjera  

Nakon što smo pročitali uvjete pružanja usluge, gumbom „Prihvadam. Izradi moj račun“ 
završavamo s otvaranjem korisničkog računa i možemo se njime služiti.  
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 Sl. 24. Uvjeti pružanja usluge 

S web obrascima se na Internetu često susredemo, bilo da se radi o sudjelovanju u 
nagradnim igrama ili anketama, otvaranju e-mail korisničkih računa (npr. Gmail, Yahoo! 
Mail), isl. Prilikom popunjavanja obrasca trebamo: upisivati tekst u tekstualne okvire, birati 
između više ponuđenih vrijednosti, kvačicom označavati potvrdne okvire, odabrati 
mogudnost koja se nudi u padajudem izborniku,... Nakon popunjavanja obrasca, upotrebom 
gumba: Šalji, Send, Submit ili slično, aktiviramo prijenos podataka. Imajte na umu da 
ostavljanje osobnih podataka na sumnjivim stranicama može rezultirati neželjenim 
posljedicama. 

 

KORIŠTENJE TRAŽILICA 

Postoji mnoštvo alata za pretraživanje, a neki od najpopularnijih su Google, Yahoo!, Bing, 
Ask, AOL Search, Baidu, Wolfram Alpha.  

Prilikom pretraživanja se preporuča: 

 umjesto opdenitih kategorija, koristiti izraze koji pobliže određuju pojam (npr. 
umjesto pojma mačka, precizirat demo vrstu - sijamska mačka).  

 koristiti sinonime ili alternativne izraze  

 traženi izrazi bi trebali biti kratki, jasni i precizni – sa što manje riječi, izraziti što više 

 omeđivanje izraza navodnicima „“ – rezultat pretrage su stranice koje sadrže taj niz 
riječi, tj. tu frazu 

Opcije naprednog pretraživanja tražilice Google: 

 sa svim riječima – vrada rezultate vezane uz sve riječi koje smo napisali 

 s točnim izrazom – vrada rezultate s točno tim izrazom (npr. „ljekovito bilje“) 

 s barem jednom riječi – vrada rezultate s barem jednom riječi iz pretrage (npr. 
ljekovito OR bilje) 

 bez riječi – vrada rezultate bez nekih izraza (npr. biljke –otrovne izostavlja otrovne 
biljke iz pretrage)  

 jezik – ovom opcijom odabiremo jezik stranice koju tražimo 

 regija – ovdje biramo stranicu iz određene zemlje 

 format datoteke – npr. određujemo da nam se prikazuju samo datoteke s 
ekstenzijom .xlsx 

 datum – utvrđujemo starost traženih podataka (npr. pretražujemo vijest koja je 
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objavljena u protekla 24h) 

 pojavljivanja – određujemo da se traženi pojmovi nalaze u naslovu (npr. allintitle: 
sijamska mačka), tijelu dokumenta, url-u… 

 domena – riječ ili frazu tražimo na određenoj domeni ili web stranici (npr. sijamska 
mačka site:hr.wikipedia.org) 

 slično – pronalazi stranice slične stranici koju tražimo (npr. related:wikipedia.com) 

 veze – kao rezultat vrada stranice koje su povezane sa stranicom koju smo pretraživali 

 

Sl. 25. Tražilica Google – opcije naprednog pretraživanja web-a 

 

Pretraživanje rječnika i web enciklopedija 

Na Web-u možemo pretraživati i Web enciklopedije te rječnike. Wikipedia - slobodna 
enciklopedija te Britannica - The Online Encyclopedia su primjeri enciklopedija, a Rječnik.net 
e-rjecnik.net,  Eudict.com su primjeri rječnika. 

  

http://hr.wikipedia.org/wiki/Glavna_stranica
http://www.britannica.com/
http://www.rjecnik.net/
http://www.e-rjecnik.net/
http://www.eudict.com/
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IZLAZNI PODACI SA WEB-A 

SPREMANJE DATOTEKA 

Spremanje Web stranice na određenu lokaciju na disku: 

 Gumb  Alati (Tools) → Datoteka (File) → Spremi kao (Save as) 

 * Traka izbornika (Menu bar) → Datoteka (File) → Spremi kao (Save as) 

 Kombinacija tipki Ctrl + S 

*Po zadanom, Traka izbornika (Menu bar)  se ne prikazuje, potrebno ju je uključiti 

Otvara se dijaloški okvir Spremi web stranicu (Save Webpage), pomodu kojeg možemo 
spremiti stranicu na neku lokaciju na čvrstom disku. Stranicu možemo spremiti kao: 

 Web-stranica, kompletna (Webpage, complete) – spremamo sve datoteke povezane 
sa stranicom (uključujudi ) 

 Web-arhiva, jedna datoteka (Web Archive, single file) – sve podatke spremamo u 
jednu datoteku 

 Web-stranica, samo 
HTML (Webpage, 
HTML only) – 
spremamo samo 
trenutnu stranicu 
bez grafičkih prikaza, 
zvukova ili drugih 
datoteka 

 Tekstna datoteka 
(Text File) – 
spremamo samo 
tekst s trenutne web 
stranice 

Sl.26. Dijaloški okvir Spremi web stranicu (Save Webpage) 

Preuzimanja datoteka sa Web stranice na određenu lokaciju na disku 

S web stranica možemo preuzimati i datoteke različitog sadržaja. One su na stranici 
prikazane u obliku hiperveza (linkova), a možemo ih preuzeti pritiskom lijeve tipke miša na 
hipervezu (tj. aktiviranjem hiperveze) ili pritiskom desne tipkom miša na hipervezu te 
odabirom naredbe Spremi cilj kao… (Save Target As…). 

Kopiranje sadržaja Web stranice u dokument 

Sliku, tekst ili URL kopiramo tako da ih označimo, pritisnemo desnu tipku miša i u brzom 
izborniku odaberemo naredbu Kopiraj (Copy), a zatim naredbom Zalijepi (Paste) zalijepimo 
u dokument. 
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ISPIS 

Pripremanje Web stranice za ispis: promjena orijentacije stranice, veličine papira, margina 

 Gumb  Tools (Alati) → Ispis (Print) → Postavljanje stranice... (Page Setup...) 

 *Traka izbornika (Menu bar) → Datoteka (File) → Postavljanje stranice... (Page 
Setup...) 

* Po zadanom Traka izbornika (Menu bar) se ne prikazuje, potrebno ju je uključiti 

Otvara se dijaloški okvir Postavljanje stranice (Page Setup) u kojem podešavamo: 

 Margine (Margins) – Lijeva (Left), Desna (Right), Gornja (Top), Donja (Bottom) 

 Veličinu papira (Paper Size) – A3, A4, Pismo (Letter) 

 Orijentaciju (Orientation) – Portret 
(Portrait) ili Krajolik (Landscape) 

 izgled Zaglavlja (Header) i Podnožja 
(Footer) stranice 

  

 

 

Sl.27. Dijaloški okvir Postavljanje stranice  
(Page Setup) 

Pretpregled ispisa (Print Preview) 

Naredba Pretpregled ispisa (Print Preview) se koristi za pregledavanje stranice prije ispisa. 
Za prikaz web stranice u pogledu Pretpregled ispisa (Print Preview) koristimo: 

 gumb  Tools (Alati) → Ispis (Print) → Pretpregled ispisa (Print Preview) 

 *Traka izbornika (Menu bar) → Datoteka (File) → Pretpregled ispisa (Print Preview) 

* Po zadanom, Traka izbornika (Menu bar) se ne prikazuje, potrebno ju je uključiti 

Za pristup postavkama ispisa koristimo:  

 gumb  Tools (Alati) → Ispis (Print) → Ispis (Print) 

 *Traka izbornika (Menu bar) → Datoteka (File) → Ispis (Print) 

 Kombinacija tipki Ctrl + P 

* Po zadanom, Traka izbornika (Menu bar) se ne prikazuje, potrebno ju je uključiti 
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Otvara se dijaloški okvir Ispis (Print), u kojem možemo odrediti: 

 Opseg ispisa (Page Range) – Sve (All) – ispisuje sve stranice datoteke; Odabir 
(Selection) – ispisuje samo označeni dio sadržaja datoteke; Trenutna stranica 
(Current) – ispisuje se stranica na kojoj se trenutno nalazimo; Stranice (Pages) – 
ispisuje se zadani raspon stranica (npr. 5-7) ili pojedina stranica 

 Broj kopija (Number of copies) - unosimo broj kopija koji de se ispisati 

 Sl.28. Dijaloški okvir Ispis (Print) 
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Dio 2 Komunikacija 

ELEKTRONIČKA KOMUNIKACIJA 

OSNOVNI TERMINI  

Elektronička pošta (e-mail) je usluga prijenosa tekstualnih poruka putem Interneta. Najstariji 
je servis i jedan od najučestalijih oblika komunikacije na Internetu.  

Adresa elektroničke pošte sastoji se od korisničkog imena, znaka @ („at“;“pri“) i naziva 
računala na kojem korisnik prima poštu (npr. marko.maric@gmail.com).  

SMS (Short Message Service) je naziv za uslugu slanja tekstualnih poruka (do 160 
znakova)putem GSM standarda (Global System for Mobile Communications).  

VoIP (Voice over Internet Protocol) je naziv za tehnologiju koja omoguduje digitalizaciju i 
prijenos zvučne komunikacije (i multimedijskih sesija) putem internetske mreže. U vedini 
slučajeva omogudava besplatno telefoniranje s računala na računalo te jeftinije telefoniranje 
s računala na mobitele i fiksnu liniju. 

IM (Instant Messaging) servise koristimo za slanje istovremenih poruka, odnosno 
komunikaciju u realnom vremenu. Osim tekstualne komunikacije i video poziva, omoguduju i 
prijenos datoteka. Neki od popularnih IM servisa su: Windows Live Messenger, Skype, 
Google Talk... 

Pojam „virtualna zajednica“ podrazumijeva grupu ljudi, bez obzira na njihov geografski 
položaj, koji komuniciraju putem društvenih mreža, foruma, IM servisa, blogova itd.  

Društvene mreže (Social Networking) su besplatni online servisi, usmjereni na povezivanje 
korisnika/ica s drugim članovima/ica mreže (na osnovu poznanstva, zajedničkih interesa, 
aktivnosti i sl.). Korisnicima se, pritom, pružaju različite mogudnosti izražavanja i prezentacije 
Neke od popularnijih društvenih mreža su Facebook, Twitter, Myspace, Linkedin, G+. 

Forum je usluga koja korisnicima omoguduje razmjenu mišljenja i iskustava vezanih uz neku 
temu. Mogli bi ga usporediti s oglasnom pločom na koju sudionici ostavljaju svoje poruke, a 
drugi ih komentiraju. 

Blog (weblog) je oblik internet zapisa u kojem korisnik piše o nekoj temi. Mogu biti osobni 
(forma internet dnevnika), tematski, u obliku časopisa... 

MMO (Massive Multiplayer Online) su mrežne igre koje na Internetu igra veliki broj igrača. 
Jedan od podžanrova MMO-a je MMORPG (Massive Multiplayer Online Role-Playing Game), 
a njegov najpopularniji predstavnik je igra Warcraft.  

 

 

http://www.facebook.com/
http://twitter.com/
http://www.myspace.com/
http://www.linkedin.com/
https://www.gplus.com/
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SIGURNOST 

Pojam spam podrazumijeva neželjenu, masovno distribuiranu elektroničku poštu (reklame, 
obavijesti o temama na koje niste pretpladeni, lažne privatne poruke i sl). Spam može 
sadržavati spyware, virus, ili sličan maliciozni program.   

Savjeti: 

 ne ostavljajte privatnu e-mail adrese na nepouzdanim web stranicama  

 kreirajte privremene e-mail adrese koju, koje dete koristiti za registraciju na 
neprovjerenim web stranicama 

Od spam-a se štitimo specijaliziranim programima, tzv. anti-spam zaštita, a ukoliko ipak 
primimo poruku nepoznatog pošiljaoca, osobito sa privitkom, najbolje je takve poruke 
obrisati bez otvaranja. 

Pojam Phishing se odnosi na oblik prijevare u kojoj se osobe lažno predstavljaju, koristedi 
pritom krivotvorene e-mail poruka i web stranice, s ciljem stjecanja povjerljivih informacija 
(broj kreditne kartice, lozinke...). 

Računalni virus je zlonamjeran program, prepoznatljiv po mogudnosti autoreplikacije. Nužno 
je biti oprezan kod otvaranja privitaka (attachment) e-mail poruka poslanih s nama 
nepoznate adrese, jer bi lako mogli biti računalni virusi. Izvršni privici mogu se pojaviti u 
obliku mnoštva nastavaka (ekstenzija), a najučestaliji su: bat, exe, pif, scr, cmd, vbs, js. 

Digitalni potpis je elektronska oznaka koja se datoteci ili poruci dodaje u svrhu potvrde njene 
autentičnosti i identifikacije njenog autora. Valjani digitalni potpis potvrđuje da datoteka (ili 
poruka) nije mijenjana otkako je digitalno potpisana. 

 

O ELEKTRONIČKOJ POŠTI 

Prednosti elektroničke pošte 

 brzina - jedna od prednosti elektroničke pošte je svakako brzina koja podrazumijeva 
momentalnu mogudnost odgovora 

 isplativost - u odnosu na klasičnu poštu (osobito međunarodni promet), ona je 
itekako isplativa 

 brojne opcije – čitanje, spremanje, slanje, prosljeđivanje, potvrda prijema, odgađanje 
slanja itd. 

Pravila pristojnosti (netiquette) 

 elektronička pošta nije sigurna – povjerljive podatke ne šaljemo ukoliko ih nismo 
kriptirali 
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 ukoliko prosljeđujemo poruku, ne mijenjamo joj sadržaj (ako citiramo dijelove – 
navodimo autora) 

 ne šaljite lance srede 

 ne koristite velika slova – u komunikaciji na internetu, to se smatra vikanjem 

 emotikone koristite s mjerom 

 koristite kratke i precizne naslove 

 provjerite pravopis i gramatiku 

 ako šaljete kopiju poruke na drugu e-mail adresu, naznačite to unošenjem te e-mail 
adrese u polje CC (Carbon Copy) 

Ograničenja veličine privitka 

Elektronička pošta nije namijenjena za slanje velikih količina podataka (za to koristimo FTP). 
Vedina administratora poslužitelja i davatelja usluga pristupa internetu postavlja ograničenja 
na ukupnu veličinu poruke (sadržaj + privitak). Google je tako odredio maksimalnu veličinu 
privitka Gmail računa na 25 MB (napomena: ovaj podatak je podložan promjeni).  
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KORIŠTENJE ELEKTRONIČKE POŠTE 

SLANJE ELEKTRONIČKE POŠTE 

Microsoft Outlook možemo otvoriti kao i svaki drugi Microsoft Office program: 

 korištenjem prečaca (shortcut) Microsoft Outlook-a, koji se obično nalazi na radnoj 
površini (desktop) računala, ili 

 preko izbornika Start  Svi programi (All Programs)  Microsoft Office  
Microsoft Outlook.  

Program zatvaramo pritiskom lijeve tipke miša na manipulacijski gumb Zatvori (Close)  , 
koji se nalazi u gornjem desnom kutu prozora ili u izborniku Datoteka (File) odabirom 
naredbe Izlaz (Exit). 

Pretpregled poruke dobivamo pritiskom lijeve tipke miša na poruku, a otvaramo je 
dvostrukim pritiskom lijeve tipke miša. Zatvaramo ju pritiskom na manipulacijski gumb 
Zatvori (Close)  koji se nalazi u gornjem desnom kutu prozora ili u izborniku Datoteka 
(File), naredbom Zatvori (Close). 

 

Kreiranje nove elektroničke poruke 

Novu e-mail poruku kreiramo tako da pritisnemo lijevu tipku miša na alat Nova poruka e-
pošte (New E-mail), koji se nalazi na kartici Polazno (Home). Otvara se novi prozor sa 
slijededim poljima:  

 polje Prima (To) je standardno polje za unos adrese primatelja elektroničke pošte. 

 polje Kopija (Cc, Carbon Copy) je polje za e-mail adresu primaoca kopije poruke. 
Adresa unesena u polje Cc de biti vidljiva ostalim primateljima poruke.  

 polje Skrivena kopija (Bcc, Blind Carbon Copy) je također polje za e-mail adresu 
primaoca kopije poruke, s tim da adresa unesena u polje Bcc nede biti vidljiva ostalim 
primateljima poruke.  

 polje Predmet (Subject) je polje za naslov poruke  

 

Kopiranje teksta iz nekog drugog izvora u poruku 

Da bi neki tekst ili objekt premjestili ili kopirali u poruku, potrebno ga je prvo označiti. Nakon 

što smo ga označili, pritisnemo desnu tipku miša i u brzom izborniku potražimo naredbu 

Izreži (Cut) (ako ga želimo izrezati) ili Kopiraj (Copy) (ako ga želimo kopirati). Zatim  se 

pozicioniramo pokazivačem miša na mjesto u poruci na koje želimo premjestiti ili kopirati 

tekst. Pritiskom na desnu tipku miša, otvara nam se brzi izbornik u kojem odabiremo 
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naredbu Zalijepi (Paste).  

Naredbe  Izreži (Cut), Kopiraj (Copy) i Zalijepi (Paste) možemo pokrenuti i kombinacijama 

tipki: 

 Ctrl + X  - Cut 

 Ctrl + C  - Copy 

 Ctrl + V  - Paste 

 

Sl.29. Primjer elektroničke poruke 

 

Prilog (Attachment) elektroničkoj poruci 

Elektroničkoj poruci koju šaljemo možemo umetnuti jednu ili više datoteka (tekstualnih, 
slikovnih) koji se onda nazivaju prilozi ili privitci. Privitke (Attachments) dodajemo putem 

kartica Poruka (Message) ili Umetni (Insert), klikom na alat . Otvara se dijaloški okvir 
Umetni datoteku (Insert File) u kojem označimo datoteku koju želimo umetnuti i gumbom 
Umetni (Insert) potvrđujemo odabir. Privitak uklanjamo tako da ga označimo i pritisnemo 
tipku Delete, ili nakon označavanja pritisnemo desnu tipku miša i sa brzog izbornika 
odaberemo naredbu Ukloni (Remove).  
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Skica (Draft) elektroničke poruke. 

Skica poruke se, po zadanom, automatski pohranjuje u mapu Skice (Drafts) svake 3 minute. 

Ukoliko sami želimo spremiti skicu elektroničke poruke: 

 u prozoru Poruka (Message) koristimo naredbu Spremi (Save), koja se nalazi na 

kartici Datoteka (File) 

 u prozoru Poruka (Message) pritisnemo gumb  Spremi (Save) , koji se nalazi na 

Alatnoj traci za brzi pristup (Quick Access Toolbar) 

 

Pravopis i gramatika  

Pravopis i gramatiku provjeravano odabirom alata  Pravopis i gramatika (Spelling & 

Grammar)  koji je smješten na kartici Pregled (Review), u grupi Lektura (Proofing),.  

 

Slanje poruke 

Poruku šaljemo pritiskom na gumb Pošalji (Send)  koji se nalazi lijevo od polja za unos 
adrese. 

 

Slanje poruke s visokim ili niskim prioritetom 

Ukoliko šaljemo poruku s visokim prioritetom, istaknut demo to upotrebom alata  Visoka 

važnost (High Importance), dok za poruku niskog prioriteta koristimo alat  Niska važnost 
(Low Importance). Navedeni alati se nalaze unutar prozora poruke na kartici Poruka 
(Message) u grupi Oznake (Tags).  

 

PRIMANJE ELEKTRONIČKE POŠTE 

Odgovori, Odgovori svima 

Pošiljatelju primljene poruke odgovaramo upotrebom alata Odgovori (Reply) , koji se 
nalazi na kartici Polazno (Home), u grupi Odgovori (Respond).  
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Pritiskom na gumb  Odgovori svima (Reply to All) , na kartici Polazno (Home), u grupi 
Odgovori (Respond), odgovaramo pošiljatelju i svim primateljima poruke.  

Poruka koju šaljemo kao odgovor na primljenu poruku, ispred naslova primljene poruke ima 
prefiks „Re:“ te ako je primljena poruka imala privitak (attachment), odgovor koji šaljemo ga 
ne sadrži. 

Prosljeđivanje elektroničke poruke 

Primljenu poruku možemo proslijediti na neku drugu e-mail adresu upotrebom alata 

Proslijedi (Forward) , koji se nalazi na kartici Polazno (Home), u grupi Odgovori 

(Respond). Proslijeđena poruka ispred naslova primljene poruke ima prefiks „Fw:“ te se 

prosljeđuje sav sadržaj primljene poruke, uključujudi i privitke (attachments) koji se mogu ukloniti ili 

dodati novi. 

Otvaranje priloga 

Priloge koje smo dobili zajedno s porukom možemo spremiti na računalo. Možemo pritisnuti 
lijevu tipku miša na prilog da bismo pregledali datoteku u prilogu. Pritiskom desne tipke miša 
na prilog i odabirom naredbe Spremi kao… (Save as…) otvara se dijaloški okvir pomodu kojeg 
odredimo ime i lokaciju na disku gdje želimo spremiti prilog. 

Ispisivanje poruke  

Odabirom naredbe Ispis (Print), na kartici Datoteka (File) poruku prije ispisa možemo 

pregledati (Print Preview) te napraviti eventualne izmjene prije ispisa, ili direktno ispisati 

(Print) poruku. 

 

POVEDANJE PRODUKTIVNOSTI  

Odgovaranje sa i bez uključivanja originalne poruke. 

Poruke koje šaljemo kao odgovore na primljene poruke mogu a i ne moraju sadržavati tekst 
primljene poruke. Na kartici Datoteka (File), odaberite naredbu Mogudnosti (Options). U 
otvorenom dijaloškom okviru Mogudnosti programa Outlook (Outlook Options), kliknite na 
karticu Pošta (Mail)  te sa padajudeg izbornika odaberite:   

 Zanemari izvorni tekst poruke (Do not include original mesage) – prilikom odgovora 
na poruku ne uključujemo originalni tekst 

 Uključi tekst izvorne poruke (Include original message text) – prilikom odgovora na 
poruku uključujemo prikaz originalnog teksta 
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Sl.30. Postavke za odgovaranje na poruku 

 

Postavljanje i micanje zastavice sa elektroničke poruke 

Ukoliko planiramo kasnije raditi na elektroničkoj poruci, možemo postaviti zastavicu na nju 
koja služi kao vizualni podsjetnik. Prije postavljanja zastavice, poruku je 
potrebno označiti. Na kartici Polazno (Home), u grupi Oznake (Tags), 

kliknemo na Daljnje pradenje (Follow Up)  te u padajudem izborniku 
odaberemo odgovarajudu zastavicu. Zastavice uklanjamo naredbom 
Očisti zastavicu (Clear Flag) nakon označavanja određene poruke, ili 
dvostrukim pritiskom lijeve tipke miša na dotičnu zastavicu. 

 

Sl.31. Izbornik - postavljanje zastavica 
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Oznaka za pročitane i nepročitane poruke 

Nakon što smo označili ved otvorenu (pročitanu) poruku, pritisnemo desnu tipku miša i u 
izborniku odaberemo naredbu Označi kao nepročitano (Mark as Unread). Dotična poruka  je 
označena kao nepročitana, tj. podebljana je kao nepročitane poruke. U drugom slučaju (ako 
se radi o nepročitanoj poruci), odabiremo naredbu Označi kao pročitano (Mark as Read). 

 

Alatne trake - obnavljanje, minimiziranje  

Vrpcu (Ribbon) podešavamo u izborniku Datoteka (File). Kliknemo na Mogudnosti (Options) 
i odaberemo karticu Prilagodi vrpcu (Customize Ribbon). Ako neku od zadanih kartica ne 
želimo prikazivati, jednostavno uklonimo kvačicu pokraj nje. Ponuđena nam je i mogudnost 
kreiranja vlastite kartice (New Tab) koju je mogude podesiti tako da u potpunosti odgovara 
našim potrebama. Na lijevoj strani dijaloškog okvira odaberemo željeni alat i klikom na gumb 
Dodaj (Add) ga dodamo kartici. Ako alat želimo ukloniti s kartice, označimo ga i kliknemo na 
gumb Ukloni (Remove). 

 

Sl. 32. Dijaloški okvir Mogudnosti programa Outlook (Outlook Options) –  
kartica Prilagodi vrpcu (Customize Ribbon) 
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Desnim klikom na Vrpcu (Ribbon) otvaramo brzi izbornik sa slijededim opcijama: 

 Prilagodi Alatnu traku za brzi pristup (Customize Quick Access Toolbar) – 
prilagođavamo izgled Alatne trake brzog izbornika 

 Prikaži Alatnu traku za brzi pristup ispod Vrpce (Show Quick Access Toolbar Below 
the Ribbon) - Quick Access Toolbar premještamo ispod Vrpce 

 Prilagodi vrpcu Customize the Ribbon – prilagođavamo Vrpcu 

 Minimiziraj vrpcu (Minimize the Ribbon) – minimiziramo Vrpcu 

 Sl.33. Prilagođavanje alatnih traka 

 

Funkciju pomodi pozivamo: 

 pritiskom funkcijske tipke F1 

 klikom na ikonu  Pomod programa Microsoft Outlook (Microsoft Outlook Help) , 
koja se nalazi ispod manipulacijskih gumbi 

 odabirom naredbe Pomod (Help) koja se nalazi na kartici Datoteka (File),  
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ORGANIZACIJA ELEKTRONIČKE POŠTE 

Elektroničke poruke možemo pretraživati po raznim kriterijima: pošiljatelju, predmetu 
(naslovu), datumu primitka, privitku itd. Poruke pretražujemo tako da se pozicioniramo u 
neku od mapa u navigacijskom oknu te u okvir Pretraži (Search) upišemo željeni pojam.  

 

Sl. 34. Okvir Pretraži Inbox (Search Inbox) 

Klikom na okvir Pretraži (Search) (ili upotrebom prečaca na tipkovnici Ctrl + E), aktiviramo 
novi odjeljak - Alati za pretraživanje (Search Tools) na vrpci. Na njegovoj kartici 
Pretraživanje (Search), u grupi Ugađanje (Refine), određujemo kriterij pretrage:  

 Šalje (From)  

 Predmet (Subject)  

 Ima privitke (Has Attachments) itd. 

 

Sl. 35. Odjeljak Alati za pretraživanje (Search Tools) 

Korištenjem prečaca na tipkovnici Ctrl+Shift+F otvaramo dijaloški okvir Napredno 
pretraživanje (Advanced Find), u kojem možemo koristiti dodatne opcije pretraživanja.  

 

Sortiranje elektroničkih poruka  

Poruke možemo sortirati prema datumu (Date), veličini (Size), privitku (Attachments), 
poljima Šalje (From),  Prima (To) itd. Sortiranje poruka obavljamo putem kartice Prikaz 
(View), tako da u grupi Raspored (Arrangement) odaberemo parametar prema kojem 
želimo sortirati poštu.  

Sl.36. Kartica Prikaz (View) - sortiranje poruka 
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Mape za elektroničke poruke 

S ciljem bolje organizacije primljenih i poslanih poruka, možemo kreirati nove mape i 
premjestiti u njih poruke vezane za, npr., određeni projekt. 

 

Sl.37. Kartica Mapa (Folder) - kreiranje nove mape 

Odaberite mapu Pošta (Mail) u donjem dijelu navigacijskog 
okna (na lijevoj strani ekrana). Na kartici Mapa (Folder) u 
grupi Novo (New), kliknite na ikonu Nova mapa (New 
Folder). Otvara se dijaloški okvir Kreiraj novu mapu 
(Create New Folder), u kojem unosimo ime (name) mape, 
određujemo vrstu sadržaja mape (folder contains) te 
odabiremo gdje de mapa biti smještena (select where to 
place folder), tj. unutar koje mape. 

 

Sl.38. Dijaloški okvir Kreiraj novu mapu  
(Create New Folder) 

Za brisanje mape je dovoljno pozicionirati se pokazivačem na mapu, pritisnuti desnu tipku 
miša i iz brzog izbornika odabrati naredbu Izbriši mapu (Delete Folder). Prije brisanja mape 
trebamo još jednom potvrditi naredbu i stavke u toj mapi se premještaju u mapu Pobrisane 
stavke (Deleted Items). 

Da bi premjestili neku poruku u drugu mapu prvo je moramo označiti. Nakon što smo je 
označili pritisnemo desnu tipku miša iznad nje i 
u brzom izborniku odabiremo naredbu 
Premjesti u mapu (Move To Folder). U 
otvorenom dijaloškom okviru Premjesti stavke 
(Move Items) označimo mapu u koju 
premještamo poruku u postojedu mapu. 
Također imamo mogudnost kreiranja nove 
mape upotrebom gumba Novo (New) čime se 
otvara dijaloški okvir Kreiraj novu mapu 
(Create New Folder) (Sl. 38.). Na kraju, 
premještanje poruke završavamo klikom na 
gumb U redu (OK).  

Sl.39. Dijaloški okvir Premjesti stavke (Move Items) 
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Drugi način premještanja poruke u drugu mapu je uhvati-povuci-pusti (drag and drop) 
metodom: 

1. pritisnemo i zadržimo lijevu tipku miša na određenoj poruci 
2. odvučemo pokazivač miša do mape u kojoj želimo premjestiti poruku 
3. otpustimo lijevu tipku miša i poruka je premještena na novu lokaciju 

  

Brisanje elektroničke poruke 

Nakon što označimo određenu poruku, možemo je izbrisati na jedan od slijededih načina: 

 gumb Izbriši (Delete) na alatnoj traci 

 tipka Delete na tipkovnici 

 pritisnemo desnu tipku miša na označenoj poruci (pozivanje brzog izbornika) i 

odaberemo naredbu Izbriši (Delete) 

Obrisane poruke se premještaju u mapu Izbrisane poruke (Deleted Items).  

 

Vradanje obrisanih elektroničkih poruka 

Za vradanje obrisane poruke u mapu u kojoj se nalazila prije brisanja, označimo poruku u 
mapi Izbrisane poruke (Deleted Items), te nakon pritiska desne tipke miša na nju odabiremo 
naredbu Premjesti (Move). Otvara se dijaloški okvir Premjesti stavke (Move Items) (Sl. 39.) 
u kojem označimo drugu, postojedu mapu (uključujudi Inbox, Sent, Drafts) ili kreiramo novu 
mapu te potvrdimo premještanje gumbom OK.  

Obrisane poruke se također mogu premjestiti u drugu mapu metodom uhvati-povuci-pusti 
(drag and drop), koja je gore opisana.  

Pražnjenje mape sa obrisanim elektroničkim porukama 

Mapu s izbrisanim stavkama praznimo tako da na mapi Izbrisane stavke (Deleted Items) 
pritisnemo desnu tipku miša i iz brzog izbornika odaberemo naredbu Isprazni mapu (Empty 
Folder). 
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ADRESAR 

Za pregledavanje spremljenih kontakata odaberite mapu Kontakti (Contacts) u donjem dijelu 
navigacijskog okna (na lijevoj strani ekrana). Za unos novog kontakta na kartici Polazno 
(Home), u grupi Novo (New), kliknite na Novi kontakt (New Contact).  

 

Sl.40. Stvaranje novog kontakta (New Contact) 

Otvara se obrazac (Sl. 41.) sa tekstualnim poljima u koja unosimo podatke o kontaktu: 

 Ime i prezime (Full Name) 

 Tvrtka (Company) 

 Naziv radnog mjesta (Job title) 

 E-pošta (E-mail), itd. 

Nakon unosa podataka, za spremanje promjena i zatvaranje obrasca koristimo alat Spremi i 
zatvori (Save & Close). 

Sl.41. Podaci o kontaktu 
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Drugi način spremanja kontakta je direktno iz e-mail poruke: pritisnemo desnu tipku miša na 
e-mail adresu pošiljatelja/ice ili primatelja/ice bilo koje poruke te iz brzog izbornika 
odabiremo naredbu Dodaj u kontakte programa Outlook (Add to Outlook Contacts). 
Ponovno se otvara obrazac za kontakt (Sl. 41.) sa ved unesenim imenom te e-mail adresom. 
Te podatke možemo mijenjati, kao i dodati nove podatke te na potvrđujemo unos i 
zatvaramo obrazac za kontakt alatom Spremi i zatvori (Save & Close).  

 

Distribucijske liste 

Distribucijske liste koristimo  ako želimo slati poruke vedem broju primatelja, a ne želimo 
unositi e-mail adresu svakog primatelja posebno. U tom slučaju, prilikom slanja poruke u 
polje Prima (To) upisujemo ime liste i poruka de biti poslana svim članovima liste. 

Za kreiranje distribucijske liste odaberite mapu Kontakti (Contacts) u donjem dijelu 
navigacijskog okna (na lijevoj strani ekrana). Na kartici Polazno (Home), u grupi Novo (New), 
kliknite na Nova grupa kontakata (New Contact Group).  

 

Sl.42. Kreiranje nove grupe kontakata (New Contact Group) 

U otvorenom prozoru Grupa kontakata (Contact Group), pod poljem Naziv (Name), 
upisujemo ime nove grupe kontakata (distribucijske liste). Pritiskom na gumb Dodaj članove 
(Add Members) možemo dodati članove distribucijskoj listi, i to na 3 načina: 

 Iz mape Kontakti programa Outlook (From Outlook Contacts) 

 Iz adresara (From Address Book) 

 Novi kontakt e-pošte (New E-mail Contact) 
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Sl. 43. Kreiranje Nove grupe kontakata (New Contact Group) 

Dodavanje članova distribucijskoj listi iz Outlook kontakata ili adresara 

U padajudem izborniku 
Adresar (Address 
Book) odaberite 
odgovarajudi adresar, 
označite kontakte koje 
želite pridružiti listi i 
pritisnite gumb 
Članovi (Members).  

 

 

Sl.44. Dodavanje članova 
iz Outlook kontakata ili 

adresara 
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Dodavanje članova distribucijskoj listi kreiranjem novog kontakta e-pošte 

Osim dodavanja prethodno spremljenih kontakata, distribucijskoj listi možemo dodati člana 
čije informacije nisu prethodno spremljene. Nakon odabira alata Dodaj članove (Add 
Members) odabiremo opciju Novi kontakt e-pošte (New E-mail Contact) (Sl. 43.). 

Otvara se dijaloški okvir Dodavanje novog člana (Add New Member) u koji unosimo podatke 
(ime, e-mail adresa) te potvrđujemo unos upotrebom gumba OK. Osim kao člana 

distribucijske liste, kreirani kontakt 
možemo dodati i u mapu Kontakti 
označavanjem potvrdnog okvira Dodaj u 
kontakte (Add to Contacts).   

 

 

Sl.45. Pridruživanje novog kontakta e-pošte 

  



ITdesk.info – projekt računalne e-edukacije sa slobodnim pristupom 

ITdesk.info is licensed under a Creative Commons Attribution-  

Noncommercial-No Derivative Works 3.0 Croatia License  36/37 

 

Ovaj priručnik je namijenjen za učenje uz materijale 

objavljene na slijededim linkovima: 

 

 

 

* Skripta:  

http://www.itdesk.info/Pregledavanje Web-a i komunikacija skripta.pdf  

 

 

* Video-prezentacije koje prikazuju korištenje Interneta i e-mail-a:  

 http://www.itdesk.info/hrvatski/internet-i-e-mail-1/  

 http://www.itdesk.info/hrvatski/internet-i-e-mail-2/  

 http://www.itdesk.info/hrvatski/microsoft-outlook-1/ 

 http://www.itdesk.info/hrvatski/microsoft-outlook-2/  

 

 

* Probni ispit:  

http://www.itdesk.info/primjeri ispita/primjer ispita modul 7.pdf 

 

* Video-prezentacija koja prikazuje rješavanje primjera ispita: 

http://www.itdesk.info/hrvatski/informacije-komunikacije-video-rjesenje-ispita/  

 

* Kvizevi koji korisnici/ce sami rješavaju: 

 http://www.itdesk.info/hrvatski/informacije-komunikacije-kviz-1/ 

 http://www.itdesk.info/hrvatski/informacije-komunikacije-kviz-2/  

  

http://www.itdesk.info/Pregledavanje%20Web-a%20i%20komunikacija%20skripta.pdf
http://www.itdesk.info/hrvatski/internet-i-e-mail-1/
http://www.itdesk.info/hrvatski/internet-i-e-mail-2/
http://www.itdesk.info/hrvatski/microsoft-outlook-1/
http://www.itdesk.info/hrvatski/microsoft-outlook-2/
http://www.itdesk.info/primjeri%20ispita/primjer%20ispita%20modul%207.pdf
http://www.itdesk.info/hrvatski/informacije-komunikacije-video-rjesenje-ispita/
http://www.itdesk.info/hrvatski/informacije-komunikacije-kviz-1/
http://www.itdesk.info/hrvatski/informacije-komunikacije-kviz-2/
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OPDI UVJETI KORIŠTENJA: 

 

Web stranicu www.ITdesk.info je pokrenula udruga „Otvoreno društvo za razmjenu 

ideja - ODRAZI“ u sklopu aktivnog promoviranja ljudskog prava na slobodan 

pristup informacijama te ljudskog prava na edukaciju. 

Slobodno kopirajte i distribuirajte ovaj dokument, uz uvjet da ne mijenjate ništa u 

njemu! 

 

Nad svim programima i uslugama navedenim na web stranici ITdesk Home na web adresi ITdesk.info 

iskljucivo pravo posjeduju njihovi autori/ce. Microsoft, Windows, i Windowsxx su registrirani zaštitni 

znakovi tvrtke Microsoft Corporation. Ostali zaštitni znaci korišteni na ITdesk Home Web stranicama 

su isključivo vlasništvo njihovih vlasnika/ca. Ukoliko imate pitanja vezana uz uporabu ili 

redistribuciju bilo kojeg programa, molimo kontaktirajte autore/ice dotičnog programa. Sva dodatna 

pitanja pošaljite na info@itdesk.info.  

___________________________________ 

Ove web stranice sadržavaju linkove na ostale web stranice ili izvore. ITdesk.info team NIJE 

odgovoran za tekstualni i/ili reklamni sadržaj, odnosno za proizvode koji su na tim web 

stranicama/izvorima ponuđeni, kao što NIJE odgovoran niti za sadržaj koji je putem njih dostupan; 

mogućnost korištenja ili točnost sadržaja. Linkove koristite na vlastitu odgovornost. Također, 

ITdesk.info team ne garantira: 

 da je sadržaj na ovim web stranicama oslobođen od pogrešaka ili pogodan za svaku svrhu, 

 da će ove web stranice ili web usluge funkcionirati bez pogrešaka ili prekida, 

 da će biti odgovarajući za vaše potrebe, 

 da implementacija takvog sadržaja neće narušavati patente, autorska prava, zaštitni znak ili 

ostala prava neke treće strane. 

Ukoliko se ne slažete s ovim općim uvjetima korištenja ili ako niste zadovoljni web stranicama koje 

pružamo, prekinite s korištenjem ovih web stranica i web usluga. ITdesk.info team nije odgovoran 

vama, niti trećim osobama za bilo koju nastalu štetu, bila ona direktna, indirektna, slučajna ili 

posljedična, povezana s ili proizlazeća iz vaše uporabe, pogrešne uporabe ovih web stranica ili web 

usluga. Iako vaše potraživanje može biti bazirano na garanciji, ugovoru, prekršaju ili nekom drugom 

pravnom uporištu, neovisno o našoj obaviještenosti o mogućnosti nastanka takve štete, oslobađamo se 

svake odgovornosti. Prihvaćanje ograničenja naše odgovornosti nužan je preduvjet korištenja ovih 

web stranica i web usluga. 

Svi softveri navedeni u ovom ili drugim dokumentima objavljenim na stranici ITdesk.info su navedeni 

samo za edukativne svrhe ili kao primjer te mi, na bilo koji način, ne preferiramo navedeni softver u 

odnosu na neki drugi softver. Bilo koju izjavu da neki navedeni softver preferiramo više u odnosu na 

drugi, koji se spominje ili ne spominje u materijalima, smatrat će se kao lažni iskaz. Našu izravnu i 

bezrezervnu podršku imaju jedino softveri otvorenog koda (open source) koji omogućuju 

korisnicima/cama da bez prepreka postanu digitalno pismeni, koriste računalo i sudjeluju u modernom 

informatičkom društvu. 

http://www.itdesk.info/
mailto:info@itdesk.info
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